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RESUMO

O setor moveleiro encontra-se em expansdo, com destaque para a producdo de mobiliario a
base de madeira sélida, a qual demanda matérias-primas com elevada qualidade superficial.
A qualificacdo das madeiras destinadas a fabricacdo de moveis é realizada, majoritariamente,
em micro e pequenas empresas, por meio de avaliages sensoriais subjetivas, baseadas
principalmente no tato e na experiéncia do operador, o que dificulta a padronizacdo dos
critérios de qualidade, e reduz a competitividade do setor no que se refere ao atendimento
de normas técnicas para insercdo em mercados externos. Assim, o objetivo deste estudo foi
propor uma tecnologia de baixo custo capaz de avaliar e qualificar a superficie de madeiras
usinadas, visando a sua aplicacdo em micro e pequenas industrias do setor moveleiro. Para
tanto, foi proposto o uso de imagens associadas a técnicas de processamento digital para
analise de nove espécies de madeira, incluindo Pinus sp., Astronium lecointei (Muiracatiara)
e Eucalyptus sp., cada uma representada por trés corpos de prova, 0s quais foram
condicionados a trés diferentes tipos de umidade: absolutamente seca (AS), parcialmente
umida (PU) e submersa (SUB). As imagens foram obtidas por meio de um digitalizador e
posteriormente processadas utilizando o software livre ImageJ. Os resultados derivados do
processamento digital de imagens foram comparados com técnicas consolidadas de
qualificacdo da superficie da madeira, por meio de correlacdo de Pearson, incluindo a analise
visual conforme a norma ASTM D1666-11, a técnica sunset laser e os parametros de
rugosidade superficial Ra, Rg e Rz. A analise dos histogramas de niveis de cinza indicou
que a madeira de Muiracatiara apresentou menor variagdo na média de pixels, com 97,105
pixels, seguida da madeira de Eucalipto com 148,801 pixels, enquanto a madeira de Pinus
apresentou a maior variagdo média, com 166,910 pixels, indicando pior uniformidade
superficial entre as espécies avaliadas. A metodologia Opara, proposta visando reducdo de
custo operacional e eficacia na determinacdo da qualidade superficial da madeira usinada
obteve forte relacdo (r = 0,892) quando comparada com a analise visual e correlacdo
moderada (r = 0,672) quando comparada com a técnica sunset laser o0 que sugere ser uma
metodologia inovadora e assertiva na qualificacdo de superficies. Concluiu-se que a
metodologia baseada em histograma pode ser empregada como alternativa as técnicas de
analise visual (ASTM D 1666-11), uma vez que apresenta forte correlacdo positiva com esse
método. Em relacdo ao sunset laser, embora a correlacdo observada seja positiva moderada,
a analise por histograma apresenta vantagens, pois permite a avaliacdo da totalidade da
superficie analisada, diferentemente do sunset laser, que se restringe a areas pontuais da
amostra.



1. INTRODUCAO
A madeira € um tecido organico de origem vegetal, caracterizado por sua

heterogeneidade, anisotropia, e higroscopicidade, propriedades essas que a tornam um
material Unico e objeto de utilizacdo para diversas finalidades. Diante disso, estudos voltados
a compreensdo de seu comportamento e otimizacdo de seu uso garantem seu emprego
racional (MADY, 2017).

Entre os diversos usos da madeira, o setor moveleiro desempenha papel de destaque
na cadeia produtiva da madeira serrada. De acordo com a Associacdo Brasileira das
IndUstrias do Mobiliario (ABIMOVEL) e com dados do Relatério Setorial da Inddstria de
Moveis no Brasil, no ano de 2024 foram produzidas mais de 439,9 milhdes de pecas de
maoveis no pais, com exportagdes que totalizaram US$ 763,023 milhdes, gerando 282,724
mil trabalhadores envolvidos direta e indiretamente na cadeia produtiva.

Diante dessa relevancia econdmica e social, € necessario um controle nos processos
produtivos para a obtencdo de um produto final com padrdo de qualidade adequada. Uma
das principais métricas para avaliacdo do produto final refere-se a qualidade da superficie da
madeira, parametro influenciado por caracteristicas e propriedades fisicas, quimicas,
mecanicas e anatomicas da madeira (PEREIRA, 2017).

O conhecimento das propriedades da madeira é fundamental para se obter produtos
com parametros adequados e para previsdo do seu comportamento durante 0 processamento
garantindo maior controle no processo de usinagem. As caracteristicas fisicas da madeira
exercem influéncia na qualidade da superficie e na resisténcia ao corte. Assim, informacdes
sobre o comportamento da madeira durante a usinagem é uma necessidade ligada ao
processamento industrial, principalmente por raz6es econémicas e produtivas. Maquinas,
ferramentas e operadores envolvidos no processamento da madeira demandam informagdes
confidveis sobre os principais fatores que afetam o processo de usinagem (EYMA et al.,
2004). A qualidade da superficie da madeira representa um fator crucial para sua aplicacao
industrial, especialmente no uso da madeira solida, exercendo influéncias em etapas como
revestimento, adesivagem e usinagem. Propriedades como rugosidade, estabilidade
dimensional e presenca de defeitos superficiais interferem diretamente na performance do
material, sendo determinantes para sua viabilidade em diferentes finalidades, desde o uso
estrutural até a fabricacdo de produtos acabados (SILVA et al., 2006; ANDRADE et al.,
2016). A avaliacdo da qualidade superficial da madeira pode ser realizada por diferentes
métodos, como a andlise visual, a medicao da rugosidade e a técnica sunset laser. No entanto,

durante o processo de caracterizacdo da superficie usinada, o uso de metodologias empiricas



de baixa precisdo, como a andlise visual, pode acarretar problemas devido a falta de
padronizacéo entre avaliadores (OLIVEIRA et al., 2021).

Embora, a avaliacdo da rugosidade seja utilizada e funcional para o estudo
da superficie da madeira ap0s seu processamento mecanico, o elevado custo dos
equipamentos pode ser um entrave a sua implementagdo em micro e pequenas industrias
moveleiras.

Assim, o presente estudo teve como objetivo implementar uma tecnologia inovadora,
de baixo custo e capaz de avaliar e qualificar a superficie da madeira usinada, visando seu
emprego em micro e pequenas industrias do setor moveleiro.

2. REVISAO BIBLIOGRAFICA
2.1. FATORES QUE INFLUENCIAM A QUALIDADE DA SUPERFICIE DA
MADEIRA
As propriedades fisicas da madeira sdo as principais caracteristicas que influenciam

no corte e, consequentemente, a qualidade da superficie usinada. Entre essas propriedades,
a umidade possui influéncia na qualidade da superficie, resisténcia ao corte e energia
requerida para o processamento (ANDRADE et al., 2019). Os mesmos autores relatam que
a umidade da madeira possui relacao inversamente proporcional com a energia especifica de
corte, ou seja, maiores teores de umidade facilitam o processamento mecénico da madeira.
Esse comportamento pode ser confirmado por KOCH (1964), que ressalta que a umidade na
madeira influencia o processo de usinagem, uma vez que 0 aumento do teor de umidade
promove a reducdo da resisténcia mecanica da madeira. Essa relacdo demonstra que, para a
usinagem da madeira, é preferivel adotar um valor de umidade fixo, preferencialmente
proximo a umidade de equilibrio.

Segundo KIVIMAA (1950, apud LUCAS FILHO, 2004), a anisotropia da madeira é
umas das caracteristicas que mais influencia as propriedades fisicas e mecanicas nos planos
transversal, tangencial e radial. Em seu estudo, foi constatado que quando o corte é efetuado
na direcdo dos raios, as forcas de corte geradas sdo aproximadamente 12% superiores
aquelas observadas quando o corte ocorre perpendicularmente a essa direcao.

Além disso, aspectos anatdbmicos da madeira exercem influéncia direta sobre a
qualidade da superficie usinada. SILVA et al. (1999) constataram que, durante o processo
de usinagem, as fibras raramente sdo cortadas, resultando em defeitos e falhas ao final do
processo de usinagem, principalmente devido a grande dimensdo dos gumes de corte das
ferramentas em relagdo as dimensdes das fibras da madeira, 0 que favorece o arrancamento
e a raspagem das fibras na superficie da madeira.

A presenca de gré irregular compromete a qualidade da superficie usinada, uma vez



que o corte realizado em sentido contrario a direcdo das fibras, tornam as superficies asperas.
Ademais, elementos como células oleiferas, canais celulares e resinas, dificultam o processo
de desdobramento e beneficiamento da madeira, se aderindo as ferramentas de corte e
causando danos a superficie usinada (SILVA et al., 1999).

2.2. RUGOSIDADE
A rugosidade esta relacionada com o comportamento do material em relacdo a sua

qualidade do deslizamento (atrito), a resisténcia a corrosdo e ao desgaste, a resisténcia quanto
ao escoamento de fluidos e lubrificantes, a qualidade de aderéncia, a resisténcia a flexdo e a
fadiga, a conducgdo térmica e elétrica, a vedacdo estatica e dindmica, ao conforto e estética,
tornando-se uma caracteristica de grande importancia para a industria (WHITEHOUSE,
1994).

A rugosidade superficial da madeira € uma importante caracteristica para a qualidade
da superficie usinada, influenciando diretamente na qualidade final dos produtos de madeira
que sao fabricados (CUNHA et al., 2023)

A avaliacdo da rugosidade em materiais é realizada segundo normas técnicas, como
a NBR ISO 4287 (2002) e a 4288 (2008), que definem a avaliacdo da rugosidade de um
perfil por meio de pardmetros denominados R’s (Ra, Rq, Rk entre outros). Ao se identificar
o perfil da superficie, as irregularidades representadas por picos e vales, sdo quantificadas
pela sua altura e espacamento. Esses valores séo utilizados para o calculo dos parametros e
tornam funcional o estudo da rugosidade promovendo a compreensao dos perfis (MAHR,
1999).

2.3.  ANALISE VISUAL — NORMA ASTM D 1666-11
Esse método consiste na analise de forma subjetiva e visual da superficie da madeira

apos seu processamento mecanico. Dessa forma, a classificagdo baseada na avaliagdo visual
se torna imprecisa, uma vez que ocorre elevada variagdo nos resultados de classificacdo em
funcdo da ocorréncia de variacdo na sensibilidade de cada avaliador.

Apds a andlise visual, é feita a classificacdo da qualidade da superficie usinada
utilizando a norma ASTM D1666-87 (AMERICAN SOCIETY FOR TESTING AND
MATERIALS - ASTM, 1995). Esta metodologia avalia as fibras da madeira quanto ao
arrepiamento e arrancamento, classificando-os em niveis que variam de leve a forte, e atribui
notas que classifica a superficie usinada quanto aos defeitos existentes visiveis a olho nu,
resultantes do ataque das ferramentas de corte, identificando a necessidade de retrabalho da
peca para se obter um acabamento adequado.



2.4, SUNSET LASER
Para evitar imprecisdes do meétodo de avaliacdo visual descrito no item 2.3,

anteriormente, a técnica do sunset laser foi desenvolvida para se estabelecer classificacdes
da superficie usinada de forma mais objetiva, além de possibilitar a repeticdo das medicGes
guantas vezes necessarias, assegurando uma melhor avalia¢éo, confiabilidade e precisdo dos
resultados.

ANDRADE et al. (2016) descrevem a metodologia dessa técnica, consistindo na
iluminacdo da superficie da madeira utilizando a luz laser com baixa inclinagdo (3°),
garantindo que o feixe de luz fique quase paralelo a superficie. O feixe de luz deve cobrir
toda a extensdo da face do corpo de prova. Em seguida séo feitas imagens com camera de
alta resolucdo das superficies iluminadas pelo laser (Figura 4). Os defeitos superficiais se
mostram como imagens de areas sombreadas, isto é, com tons mais escuros. A analise é
realizada pela medicdo da area do defeito ocorrido durante o processo de usinagem.

FIGURA 4 - Setup para obtencdo das imagens para analise.
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FONTE: ANDRADE et al. (2016).

2.5. METODO OPARA
O ImageJ € um software para analise e processamento de imagens, tendo como seu

principal desenvolvedor Wayne Rasband, que projetou o software no National Institute of
Mental Health, nos Estados Unidos. O programa é escrito em linguagem Java e possui
cddigo aberto. O programa suporta imagens com profundidade de 8, 16 e 32 bits, e gera
resultados como &rea, orientacdo, perimetro, entre outras métricas, a partir de célculos

baseados na contagem de pixels. Além disso, o software permite o processamento de



diversos formatos de imagens, como TIFF, GIF, JPEG, BMP, DICOM e FITS
(SCHNEIDER et al., 2012).

3. MATERIAL E METODOS
3.1. AMBIENTACAO DOS CORPOS DE PROVA
O experimento foi realizado no Laboratorio de Usinagem e Producdo de Moveis

(LUPM) e no Laboratorio de Analise Qualitativa da Madeira (LAQM), vinculados ao
Departamento de Ciéncias Florestais da Universidade Federal de Sergipe (DCF/UFS).
Foram utilizados nove corpos de prova, distribuidos em trés diferentes espécies de madeira:
Pinus sp., Astronium lecointei (Muiracatiara) e Eucalyptus sp., resultando no total de trés
amostras para cada espécie.

Os corpos de prova foram submetidos a trés diferentes condigdes de umidade:
absolutamente seca (AS), parcialmente Umida (PU) e submersa (SUB). As condicdes
parcialmente dmida e submersa foram conduzidas em ambiente controlado, para isso foi
utilizado uma caixa plastica fechada, em que foi adicionada agua até a metade inferior,
garantindo a total imersd@o de um corpo de prova de cada espécie. A substituicdo da agua foi
realizada semanalmente para manter a uniformidade das condic¢des experimentais. Os corpos
de prova submetidos a condi¢do PU, foram acondicionados na parte superior da caixa, sem
contato direto com a agua, porém expostos a alta umidade. Dessa forma, essas amostras
permaneceram em condicdo de elevado teor de umidade devido ao ambiente saturado,
conforme Figura 5.

Por sua vez, os corpos de prova correspondentes a condicdo absolutamente seca
foram secos em estufa de ventilacdo forcada em condicdes controladas com temperatura
fixada em 103+2 °C.

FIGURA 5 - Recipiente para ambientacdo das madeiras nas condi¢des de parcialmente
Umida e submersa.



FONTE: Autor (2025).
Apdbs ambientacdo dos corpos de prova nas trés condi¢fes de umidade, estes foram

processados mecanicamente em plaina desempenadeira, equipada com cabecote de 10 cm de
diametro, contendo duas facas novas, operando a uma velocidade de corte 18,2 m.s™ (Figura
6).

FIGURA 6 - Processamento mecanico dos co
~ - 3 t‘j ‘

rpos de prova em plaina desempenadeira.
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FONTE: Autor (2025).



3.2. RUGOSIDADE, ANALISE VISUAL E SUNSET LASER
A superficie usinada foi avaliada por meio de metodologias ja consolidadas para

analise da qualidade superficial de materiais processados mecanicamente, utilizando-se as
técnicas de rugosidade, andlise visual e sunset laser. As avaliacbes foram realizadas
imediatamente ap6s o aplainamento, de modo a preservar as condi¢cBes de umidade das
amostras.

A rugosidade superficial da madeira foi avaliada por meio dos parametros Ra, Rq e
Rz, os quais sdo amplamente utilizados para a caracterizacdo de materiais bioldgicos, como
a madeira, em funcdo da sua eficiéncia na descrigéo das irregularidades superficiais (MARH,
1999). As medicdes foram realizadas com um rugosimetro de arraste, modelo SURFTEST
SJ-210 (Mitutoyo), posicionado paralelamente as fibras da madeira. O procedimento foi
conduzido conforme a metodologia descrita por Silva et al. (2006), e seguindo as diretrizes
da NBR ISO 4287 (ABNT, 2002) e NBR ISO 4288 (ABNT, 2008), que definem os
principios e parametros para a medicdo da rugosidade em superficies.

O parametro Ra ou rugosidade média corresponde a média aritmética de todos 0s
desvios do perfil na superficie em relacdo a linha média, sendo a medida mais comum, usada

amplamente na industria. A férmula para obtencdo do pardametro Ra é a seguinte:
1 (b
Ra=— [ |y(x)|dx
L Jo
Em que:
Ra: rugosidade média aritmética.
Ir: comprimento da amostragem (cut-off).

y(x): desvio vertical (pico/vale) em relacéo a linha média.

O pardmetro Rq ou rugosidade quadratica média é a raiz quadrada da média dos
quadrados das diferencas de altura entre a superficie a linha média. Em relacdo ao Ra, esse
parametro é mais sensivel a picos e vales grandes, ja que esses valores sdo elevados ao

quadrado. A formula para obtencdo do pardmetro Rq € a seguinte:
1 (b
Rq=—| 1z2*(x)|dx
L),
Em que:
RQ: rugosidade quadratica média.
I comprimento da amostragem (cut-off).

72(x): quadrado das diferencas de altura em relagéo a linha média.



O parametro Rz ou altura méxima de rugosidade é a soma do maior pico e maior vale
ao longo comprimento de medicgéo. A formula para obtencdo do parametro Rz é a seguinte:
Rz =Rp+Rv

Em que:
Rz: altura mé&xima do perfil de rugosidade.
Rp: maior pico de rugosidade.

Rv: maior vale de rugosidade.

O comprimento de amostragem adotado foi de 0,8 mm, com comprimento total de
medicdo de 8 mm. As avaliacOes foram realizadas na face de maior visibilidade das tabuas,
correspondes a sua largura. Para cada acabamento superficial, foram analisados 100 pontos
por corpo de prova, com o objetivo de reduzir a margem de erro experimental, e aumentar a
precisdo e a confiabilidade na caracterizacdo da rugosidade superficial da madeira.

A andlise visual da superficie da madeira foi conduzida de acordo com os critérios da
norma ASTM D 1666-11 (American Society for Testing and Materials — ASTM, 2011),
sendo uma forma de classificar as madeiras usinadas e auxiliar na compreensdo de sua
adequacdo para diferentes usos apds o processamento. A classificacdo da qualidade da
superficie usinada é realizada de modo a atribuir notas para a superficie usinada,
classificando-as quanto aos defeitos visiveis a olho nu (Tabela 1).

TABELA 1 - Atribuicdo de notas quanto a qualidade da superficie usinada considerando
defeitos visiveis a olho nu.

Nota Qualidade da superficie da Classificacao da superficie
madeira usinada aplainada
1 Superficie |se_nta de quaisquer Excelente
defeitos
2 Presenca de arrgplamento leve Boa
a medio
3 Presenca de arrepiamento forte Regular
e arrancamento leve
4 Presenca de arrepiamento forte Ruim

e arrancamento leve a médio
Presenga de arrancamento
5 forte, independente da presenca de Muito ruim
arrepiamento
FONTE: Adaptado de ASTM D 1666-11 (ASTM, 2011).
A avaliagdo foi realizada por trés observadores treinados. As notas atribuidas foram

comparadas inicialmente duas a duas, e posteriormente, confrontadas com a nota do terceiro
avaliador. Quando ndo houve concordancia entre as notas propostas, adotou-se a média
aritmética das trés notas para defini¢do do resultado final, conforme proposto por SILVA et
al. (2006).



O terceiro método de avaliacdo da qualidade superficial das amostras de madeira foi
realizada pela técnica sunset laser, um método ndo destrutivo que destaca imperfeicdes na
superficie utilizando iluminacéo a laser em baixa inclinacdo. Por ser ndo destrutivo, o sunset
laser pode ser aplicado durante o processo produtivo, sem que haja qualquer interferéncia no
produto final (SORAGI, 2009; ANDRADE et al., 2016).

Para a aplicacdo do método, utilizou-se um laser de diodo com comprimento de onda
de 632 nm e poténcia de 3 mW, incidindo a um angulo de 3° de modo a manter o feixe de
luz 0 mais paralelo possivel a amostra analisada. A captura das imagens foi realizada por
uma camera de um celular smartphone android, com resolugdo de 50 MP, lente de 74° e
abertura /1.8, posicionada a 30 cm de distancia da amostra e paralelamente ao plano da
superficie, assegurando a aquisi¢do detalhada das areas iluminadas pelo feixe de laser
(Figura 7).

As imagens foram processadas e analisadas por meio do software livre ImageJ,
conforme metodologia proposta por ANDRADE et al. (2016). Para aprimorar a identificagéo
das imperfeicdes, as imagens foram convertidas para escala de cinza (8-bit), ou seja, 256
niveis de cinza, e ajustadas de modo a realcar defeitos como arrancamento e arrepiamento

de fibras, que também sdo considerados na avaliacdo visual da qualidade superficial.

FIGURA 7 - Estrutura usada para a técnica sunset laser.



FONTE: Autor (2025).

3.3. METODO OPARA
3.3.1 HISTOGRAMA
A proposta desta nova metodologia consiste na obtencdo de imagens em alta

definicdo da superficie da madeira por meio de um digitalizador, seguida do processamento
dessas imagens no software ImagelJ, visando a compara¢do dos resultados com aqueles
obtidos por outros métodos de avaliacdo da qualidade superficial.

As imagens devem ser obtidas através da funcdo Scan, presente em digitalizadores,
podendo ser utilizados os formatos TIFF, GIF, JPEG, BMP, DICOM e FITS, os quais sdo
compativeis com o software ImageJ (SCHNEIDER et al., 2012). As imagens digitalizada
ndo possuem dimensdo pré-definida, sendo necessario apenas a visualizagdo da &rea de
interesse para analise. Para o presente trabalho, as imagens foram digitalizadas no
Laboratorio de Analise de Sementes (LABSEM), utilizando-se o equipamento GroundEye,
que permite a geracdo de imagens em alta definigdo para andlises detalhadas da superficie
de madeira.

Recomenda-se a criagdo de uma pasta especifica no computador destinada
exclusivamente ao armazenamento das imagens digitalizadas, de modo a facilitar sua

organizacdo, localizacdo e posterior analise. As etapas subsequentes referem-se ao



processamento e analise das imagens no software ImageJ, um programa de dominio publico,
desenvolvido em linguagem Java, disponivel em: https://imagej.net/ij/. Como etapa inicial
do procedimento da analise, a imagem deve ser aberta no ImageJ por meio da fungdo Open,
acessivel pelo caminho File > Open ou pelo atalho de teclado Ctrl+O (Figura 8).

FIGURA 8 — Selecéo das imagens para processamento.
4 Image) = >
FIN Edit Image Process Analyze Plugins Window Help

New *[’\‘A‘/Q@“J‘./ﬂ D?if!‘®‘/¢‘ ‘ | ‘:#

Open.__. Ctri+O It or long click to switch)

FONTE: Autor (2025).
A segunda etapa do procedimento é a conversdo da imagem para o padrdo digital 8

bits. Essa escolha deve-se ao fato de que, nesse formato, a imagem passa a ser representada
em uma escala em tons de cinza, podendo apresentar até 256 niveis de intensidade (valores
de 0 a 255), o que facilita a analise quantitativa por meio da ferramenta Histogram. A
conversdo da imagem para 8 bits segue a metodologia descrita por Andrade et al. (2016).
Essa ferramenta permite avaliar a distribuicdo dos valores de intensidade em uma imagem,
indicando a frequéncia de ocorréncia de cada nivel de cinza na amostra.

No contexto do presente estudo, o histograma € utilizado para calcular a distribuicéo
dos niveis de cinza presentes na imagem, fornecendo informacGes como as dimensdes da
imagem em pixels, o nimero total de pixels analisados, média dos valores de intensidade, o
desvio padréo entre outras métricas (Schneider et al., 2012). Para realizar a conversdo da
imagem para o formato 8-bit no software ImageJ, deve-se acessar o0 menu Image > Type >
8-bit (Figura 9).

FIGURA 9 — Modificacdo do tipo de imagem para 8-bit.
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FONTE: Autor (2025).
A terceira etapa consiste na aplicacdo de um filtro a imagem, especificamente o filtro

de mediana. Esse procedimento tem como objetivo a suavizacdo da imagem, promovendo a
reducdo de ruidos, uma vez que substitui o valor de cada pixel pela mediana dos valores de
pixels vizinhos (Schneider et al., 2012). Como consequéncia, ocorre a reducdo da
variabilidade dos niveis de cinza, refletida, entre outros aspectos, na reducdo do desvio

padréo obtido na analise do histograma. O filtro de mediana foi escolhido pois, apds varios



testes com diversos filtro, este foi 0 que apresentou a maior diminui¢do do desvio padréo
com a menor alteracdo do numero total de pixels, quando comparado com a imagem sem
tratamento. Para a aplicacdo do filtro de mediana, deve-se acessar 0 menu Process > Filters
> Median (Figura 10).

FIGURA 10 - Aplicacgéo do filtro de mediana para suavizagdo da imagem.
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FONTE: Autor (2025).
A quarta etapa do procedimento consiste na selecdo da area de interesse para analise

da qualidade superficial da madeira. Considerando que o método baseado no histograma
busca estabelecer uma comparacéo direta com os métodos de analise visual e sunset laser,
optou-se pela selecdo de toda a area do corpo de prova, de forma analoga as metodologias
ja consolidadas. Para essa finalidade, utilizou-se a ferramenta de selecdo por poligonos, a
qual permite a delimitacéo precisa da area do corpo de prova por meio da insercao do nimero
de pontos necessarios para contornar toda a superficie analisada. O acesso a ferramenta de
selecdo por poligonos € apresentado na Figura 11, enquanto a Figura 12 ilustra um exemplo
da area selecionada para a analise no presente trabalho.
FIGURA 11 - Ferramenta para selecéo de poligono na area desejada para anélise.
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FONTE: Autor (2025).



FIGURA 12 - Exemplo do uso da ferramenta para selecdao de poligono em imagem 8-bit.
¢ Muiracatiara 0.png (12.5%) - O X
5184x3456 pixels; 8-bit; 17MB

FONTE: Autor (2025).
A quinta etapa do procedimento corresponde a utilizacdo da funcdo de histograma,

acessivel pelo caminho Analyze > Histogram ou por meio do atalho Ctrl+H (Figura 13).
Essa ferramenta permite a analise estatistica da distribuicdo dos niveis de cinza da imagem
previamente selecionada. Para o presente estudo, os parametros de maior interesse na analise
do histograma sdo media (Mean) e desvio padrdo (StdDev), usadas para comparacdo de
médias e estimativa de erro, respectivamente, conforme exemplificado na Figura 14, por
serem métricas diretamente relacionadas a uniformidade e a variabilidade da superficie da
madeira, possibilitando a comparagdo com os resultados obtidos pelos métodos de anélise

visual e sunset laser.

FIGURA 13 - Obtencéao dos dados utilizando a ferramenta histograma.
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FONTE: Autor (2025).

FIGURA 14 - Exemplo de dados de média e desvio padréo dos pixels.
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FONTE: Autor (2025).



3.4. ANALISE ESTATISTICA

O experimento foi organizado e conduzido em forma de Delineamento Inteiramente
Casualizado (DIC), em esquema fatorial 3x3, sendo composto por trés espécies de madeira
e trés condicdes de umidade, com repeticbes dentro de cada tratamento.

A anélise de variancia (ANOVA) foi empregada para verificar a existéncia de
diferengas estatisticamente significativas entre espécies e condi¢Bes de umidade. Quando
detectada significancia pelo teste F (p < 0,05), aplicou-se o teste de médias de Scott-Knott,
por sua eficiéncia na formacdo de grupos homogéneos e ampla utilizacdo em experimentos
com produtos florestais.

Os dados obtidos foram exportados para um software de planilhas eletrénicas para
andlise estatistica, durante o trabalho, utilizou-se o software Microsoft Excel. Os valores de
média (Mean) e desvio padrdo (StdDev) foram analisados conjuntamente com os resultados
da analise visual, visando a avaliacdo da relacdo entre os métodos j& consolidados com o
método proposto. Para essa finalidade utilizou-se o coeficiente de correlagdo de Pearson (r),
criado por Karl Pearson, que mede a forca e a direcdo da relacdo linear entre duas variaveis,
assumindo valores entre -1, que indica correlacdo negativa perfeita, e +1, que representa
correlagéo positiva perfeita. O valor r igual a zero indica auséncia de correlacéo linear entre
as variveis. O coeficiente de correlagdo de Pearson foi calculado conforme a Equagdo 1:

Y im0 i)

r =
\/z{l=1 @02 T, (i-y)?

Eql

Em que:

r € o coeficiente de correlacdo de Pearson.

n é o numero de observacoes.

x; representam cada ponto de dados em uma variavel, 0 <i <n.

x € a média da variavel x.

y; representa cada ponto de dados na outra variavel, 0 <i<n.

y € amedia da variavel y.

Para a avaliacdo dos resultados obtidos com o coeficiente de correlagdo de Pearson,
utilizou-se a interpretacdo dos valores de r, conforme apresentada na Tabela 2, a qual

relaciona a magnitude do coeficiente com a intensidade da correlacdo entre as variaveis

analisadas.
TABELA 2 - Coeficiente de correlagdo de Pearson.
Coeficiente de correlagdo Correlacdo
07<r<l1 Forte correlagdo positiva

04<r<0,7 Correlacédo positiva moderada



0<r<04 Correlagéo fraca positiva

r=0 Sem correlacéo
-0,4<r<0 Correlacédo negativa fraca
-0,7<r<-0/4 Correlagdo negativa moderada
-1<r<-0,7 Forte correlacdo negativa

FONTE: Adaptado de University of Southampton.
Valores proximos a +1 indicam que as variaveis apresentam relacdo diretamente

proporcionais, ou seja, tendem a aumentar conjuntamente. Por outro lado, valores proximos
a -1 indicam uma relagdo inversamente proporcional, ou seja, 0 aumento de uma variavel
estd associado a diminuigéo da outra.

Para o calculo do coeficiente de correlacdo no Microsoft Excel utiliza-se a funcao
=PEARSON(A:A;B:B). Os dados devem estar organizados em colunas Unicas, sendo que
as colunas A e B representam, respectivamente, cada uma das variaveis analisadas. A Figura
15 ilustra um exemplo do uso da funcdo de Pearson no Excel.

FIGURA 15 - Utilizagdo da expressdo de Pearson no software Microsoft Excel.
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FONTE: Autor (2025).
Além da correlacdo de Pearson, ajustou-se um modelo de regressdo linear simples

entre a média de pixels do histograma e o(s) métodos consolidados de avalia¢do da qualidade
superficial. A Regressdo Linear Simples (RLS) é um método de estatistica para modelar a
relacdo entre uma varidvel dependente (y) e uma variavel independente (x), usada para
entender padrdes e fazer previsdes, minimizando erros. A RLS € dada pela seguinte formula:
y=PFo+pB1x

Em que:

y = variavel resposta.

X = variavel explicativa.

Jo = intercepto.

[ = coeficiente angular.

Para avaliar o modelo de regressdo usado, adotou-se a métrica RMSE (Root Mean



Squared Error) ou Raiz do Erro Quadratico Médio, que avalia a precisdo de um modelo de
regressdo, medindo o desvio padrdo de seus residuos e indicando a dispersdo dos dados em
relacdo a linha de ajuste. Valores baixos indicam que as previsées do modelo estao proximas
dos valores reais.

4. RESULTADOS E DISCUSSAO
4.1. RUGOSIDADE
Os valores médios de rugosidade demonstram que a madeira

de Muiracatiara apresentou a melhor qualidade superficial com média de 5,182 um, seguida
pela madeira de Eucalipto, que apresentou qualidade superficial intermediaria, com média
de 5,970 um, ja a menor qualidade superficial foi constatada para a madeira de Pinus, com
uma média 7,539 um. Esses resultados sdo corroborados ela analise de variancia (Tabela 3),
na qual constatou a ocorréncia de diferenca estatisticamente significativa entre as condi¢fes
avaliadas ao nivel de 5% de significancia (p < 0,05), considerando os parametros de
rugosidade avaliados.

TABELA 3 - Resumo da ANOVA para as variaveis de rugosidade Ra, Rq, Rz.

QM
FV GL
Ra Rq Rz
Madeira 2 78,309* 115,673* 1828,452*
Condicéo 8 24,654* 37,625* 594,316*
Repeticéo 99 - - -
Erro 889 - - -
CV (%) 42,95 45,64 41,72

LEGENDA: FV- FONTE de Variacdo; GL-Grau de liberdade; CV- Coeficiente de variacdo; QM- Quadrado
médio; * significativo a 5% de significancia.
FONTE: Autor (2025).

De acordo com o teste de médias Scott-Knott, ao nivel de 5%

de significancia, observa-se que a Muiracatiara apresentou 0s menores valores para 0s
parametros analisados em comparacdo as demais espécies estudadas, apresentando assim,
melhor superficie de acabamento. A madeira de Eucalipto apresentou uma melhor superficie
de acabamento para os parametros estudados em relacdo a madeira de Pinus. Por sua vez, a
madeira de Pinus apresentou os maiores valores dos parametros avaliados, evidenciando a
menor qualidade de acabamento entre as madeiras estudadas (Tabela 4).

TABELA 4 - Valores médios das espécies analisadas relativos aos parametros de rugosidade
Ra, Rq, Rz.

. Média
Espécie
Ra Rq Rz
Muiracatiara 1,925 al 2,456 al 11,164 a1
Eucalipto 2,305 a2 2,929 a2 12,677 a2

Pinus 2,937 a3 3,687 a3 15,991 a3




FONTE: Autor (2025). Médias seguidas dos mesmos ndmeros na mesma coluna sao estatisticamente iguais e
médias seguidas de nimeros diferentes na mesma coluna séo estatisticamente diferentes. Nao foi avaliada a
diferenca entre linhas.

Tal resultado pode ter relagdo com as diferentes densidades basicas das espécies
estudadas, uma vez que a espécie de maior densidade apresentou melhor qualidade
superficial, de maneira contréaria a espécie que apresentou pior qualidade superficial foi
aquela com menor densidade basica. Entretanto, outros fatores também podem influenciar
na qualidade da superficie usinada, como a direcdo da grd da madeira por exemplo, que ndo
foi objeto deste estudo (COSTA, 2020). Nota-se que, na condicdo absolutamente seca (AS),
as madeiras diferiram entre si para os trés parametros analisados. Nessa condicdo, a madeira
de Muiracatiara apresentou a melhor qualidade da superficie acabada, seguida pela madeira
de Eucalipto, enquanto a madeira de Pinus apresentou a pior qualidade de superficie usinada,
sendo estatisticamente distinta das demais.

Na condi¢do parcialmente imida (PU), para aos parametros estudados, a madeira de
Muiracatiara e de Eucalipto foram as que apresentaram a melhor qualidade superficial, ndo
diferindo estatisticamente entre si. A madeira de Pinus para a mesma condicao apresentou
maiores valores de rugosidade o que indica inferior qualidade superficial.

Na condi¢do submersa (SUB), o comportamento observado foi semelhante ao
verificado na condicdo AS. A madeira de Muiracatiara apresentou a melhor qualidade
superficial madeira de Eucalipto apresentou qualidade intermediaria e a madeira de Pinus
apresentou a pior qualidade de acabamento. As diferencas entre as espécies foram
confirmadas pelo teste de medias de Scott-Knott, ao nivel de 5% de significancia, conforme
apresentado na Tabela 5.

TABELA 5 - Valores médios das diferentes condi¢fes analisadas relativos aos parametros
de rugosidade Ra, Rq, Rz.

C?,ggé%??ada Espécie Ra (um) Rqg (um) Rz (um)
Pinus 2,739 a3 3,420 a3 14,766 a3

AS Eucalipto 2,183 a2 2,743 a2 12,009 a2
Muiracatiara 1,646 al 2,116 al 9,843 al

Pinus 2,809 a3 3,537 a3 15,488 a3

PU Eucalipto 2,321 a2 2,911 a2 12,692 a2
Muiracatiara 2,289 a2 2,924 a2 12,996 a2

Pinus 3.264 a4 4,105 a4 17,719 a4

SUB Eucalipto 2,413 a2 3,135a3 13,332 a2
Muiracatiara 1,842 al 2,328 al 10,654 al

LEGENDA: AS- absolutamente seca; PU- parcialmente Umida; S- submersa. Médias seguidas dos mesmos
nimeros na mesma coluna sdo estatisticamente iguais e médias seguidas de nimeros diferentes na mesma
coluna sdo estatisticamente diferentes. Nao foi avaliada a diferenca entre linhas.



FONTE: Autor (2025).
No que se refere a rugosidade superficial, € necessario considerar que outros fatores,

além da densidade béasica, podem exercer influéncia significativa na qualidade da superficie
das madeiras analisadas, tais como 0 processamento, a constituicdo anatbmica e a
composicao quimica da madeira (CUNHA et al., 2023; REIS et al., 2025). PEREIRA et al.
(2018) e REIS et al. (2025) ressaltam em seus respectivos estudos, que madeiras com
superficies lisas e pouco rugosas sdo objeto de interesse do setor moveleiro, uma vez que
apresentam melhor aderéncia de revestimentos. Tal afirmacdo reforca a preferéncia da
industria moveleira por espécies como a Muiracatiara (CUNHA et al. 2023).

Entretanto, os resultados obtidos neste estudo ndo inviabilizam o uso das madeiras de
Pinus e Eucalipto no setor moveleiro, uma vez que a aplicacdo de produtos de acabamento,
bem como, o lixamento, pode contribuir para a redugdo da rugosidade, promovendo
melhorias na qualidade superficial dessas madeiras (RAABE et al., 2017).

4.2. ANALISE VISUAL
A partir dos resultados da andlise visual, nota-se que, na condi¢do AS, as madeiras

de Eucalipto e de Pinus apresentaram a pior qualidade da superficie aplainada, enquanto a
madeira de Muiracatiara apresentou a melhor qualidade superficial nessa condicao.
Comportamento semelhante foi verificado na condicdo SUB, na qual a Muiracatiara
manteve o melhor desempenho quanto a qualidade superficial, ao passo que as madeiras de
Eucalipto e Pinus apresentaram as menores notas na andlise visual.

Na condi¢cdo PU, a analise visual evidenciou diferencas estatisticas entre todas as
madeiras avaliadas. Nessa condicdo a madeira de Muiracatiara apresentou a melhor
qualidade de acabamento, seguida pela madeirade Eucalipto, com desempenho
intermediario, enquanto a madeira de Pinus apresentou a pior qualidade de acabamento. As
notas atribuidas as madeiras nas trés condi¢cdes de umidade, com base na analise visual,
encontram-se apresentadas na Tabela 6.

TABELA 6 - Notas da analise visual para a qualidade da superficie usinada.
Notas da classificacdo da

Muiracatiara
SUB Pinus

Condigéo Espécie superficie usinada
Pinus 3
AS Eucalipto 3
Muiracatiara 2
Pinus 4
PU Eucalipto 3
2
3




Eucalipto 3
Muiracatiara

LEGENDA: AS — Absolutamente seca, PU — parcialmente Gmida e SUB — submersa.
FONTE: Autores (2025).

Dos nove corpos de prova analisados, a maior frequéncia de classe de defeitos

encontrado foi a de arrepiamento forte e arrancamento leve (nota 3), registrado em cinco
corpos de prova. Essa classificacdo foi atribuida a madeira de Eucalipto nas trés condi¢des
de umidade estudadas e @ madeira de Pinus em duas amostras, nas condi¢des AS e SUB. A
segunda maior frequéncia correspondeu a classe de arrepiamento leve a médio (nota 2), em
trés corpos de provas, todos para a madeira de Muiracatiara, independente da condicéo de
umidade. Somente um corpo de prova apresentou presenca de arrepiamento forte e
arrancamento leve a médio (nota 4), identificado na madeira de Pinus sob aa condicéo PU.
Nenhum corpo de prova apresentou uma superficie isenta de defeitos (nota 1), nem com
Presenca de arrancamento forte, independente da ocorréncia de arrepiamento (nota 5).

De acordo com SILVA et al. (2009), para a classificacdo da superficie usinada em
madeiras deve-se utilizar apenas duas categorias: satisfatdria e ndo satisfatoria. Com base
nesse critério, verificou-se que oito corpos de prova apresentaram qualidade satisfatoria
(notas entre 1 e 3) e somente a madeira de Pinus na condicdo de alta umidade apresentou
qualidade ndo satisfatdria (notas entre 4 e 5).

Um dos fatores que pode explicar os resultados observados estd relacionado a
densidade da madeira, que afeta diretamente a qualidade da superficie usinada. A madeira
de Pinus, classificada em literatura como baixa densidade se comporta anatomicamente
associada aos maiores diametros de lume, e por consequéncia paredes celulares mais
delgadas dos traqueideos. Essa configuracdo anatdmica, inerente a madeiras de baixa
densidade, contribui para que o rugosimetro constate picos e vales mais expressivos em
comparacdo a madeiras de densidades mais elevadas. Importante reforcar que o alto teor de
umidade, resulta em um material com baixa resisténcia mecénica. Tais caracteristicas fisicas
e mecanicas, somadas a anatomia da madeira de Pinus, constituido de traqueideos, resulta
uma pior superficie acabada devido a facilidade de rompimentos dos seus elementos
anatdmicos (GUEDES, 2020).

Segundo GUEDES (2020), outro ponto a se destacar é que, em madeiras de baixa
densidade e alto teor de umidade, o volume de material retirado durante o aplainamento é
maior que em madeiras com densidade mais alta, ocorrendo assim acimulo desses residuos
entre as laminas e a madeira, fazendo com que o material alcance altas temperaturas e com

isso facilite ainda a retirada severa de material no momento do acabamento, o que contribui



para a deterioragédo da qualidade superficial.

4.3. SUNSET LASER
Os dados referentes a porcentagem de area ocupada por defeitos, obtidos para todos

0s corpos de provas, encontram-se na Tabela 7.
TABELA 7 - Area do defeito para todas as condicdes de umidade.

Madeira Condigéo Area do defeito (%)
Eucalipto 0% 2,620
Eucalipto Alta Umidade 0,438
Eucalipto Submersa 0,181
Pinus 0% 1,921
Pinus Alta Umidade 0,703
Pinus Submersa 2,047
Muiracatiara 0% 0,128
Muiracatiara Alta Umidade 0,151
Muiracatiara Submersa 0,052

FONTE: Autor (2025).
Os valores médios para area ocupada por defeitos variaram entre 1,080% para a

madeira de Eucalipto, 1,557% para a madeira de Pinus e 0,110% para a madeira de
Muiracatiara. Por apresentar menor média de &rea defeituosa, a madeira de Muiracatiara
possui uma melhor qualidade da superficie entre as espécies avaliadas, enquanto a madeira
de Pinus apresentou a maior média, indicando maior incidéncia de defeitos na superficie
usinada. Esses resultados estdo de acordo com as notas atribuidas pelos métodos de
rugosidade (Tabela 4) e de andlise visual (Tabela 6), nos quais a madeira de Muiracatiara
apresentou as melhores notas (nota 2 - arrepiamento leve a médio). A madeira de Pinus
apresentou as piores notas com ocorréncia de - arrepiamento forte e arrancamento leve (nota
3) e, em alguns casos, arrepiamento forte e arrancamento leve a médio (nota 4).

ANDRADE (2015) em estudo semelhante, trabalho encontrou valores de 3% de area
de defeito para madeiras sem nenhum tipo de acabamento superficial. OLIVEIRA et al.
(2015) em seu trabalho encontraram valores médios de 0,13% para madeiras submetidas a
processos de acabamento. E importante destacar que o acabamento tem finalidade de
melhorar a qualidade da superficie, diminuindo a area ocupada por defeitos.

Entre os fatores que podem influenciar o aumento da area de defeitos, bem como sua
distribuicdo em pontos especificos na superficie, destaca-se a auséncia de padronizacgdo da
velocidade de avanco para os diferentes tipos de madeira. Sem o devido ajuste de parametros
de corte e forcas inadequadas para espécies com densidades distintas ocasionam um maior
desgaste da superficie durante o aplainamento em plaina desempenadeira.

Desse modo, os valores encontrados para area do defeito obtidos por meio da técnica
sunset laser poder ser considerados baixos. A madeira de Muiracatiara apresentou qualidade

suficiente dispensando técnicas de acabamento, enquanto as madeiras de Eucalipto e Pinus



apresentaram recomendacdo de retrabalho para a reducdo da area de defeitos e a melhoria
da qualidade superficial.

4.4. METODO OPARA
Os valores médios obtidos a partir da analise do histograma demonstram que a

madeira de Muiracatiara apresentou menor valor médio de pixels, com 97,105 pixels,
seguida da madeira de Eucalipto, com média de 148,801 pixels. A madeira de Pinus
apresentou o maior valor médio, com 166,910 pixels. Esses resultados encontram-se na
Tabela 8, a qual resume a analise de variancia ao nivel de 5% de significancia, resultando
em diferenca estatisticamente significativa entre as espécies avaliadas.

TABELA 8 — Resumo da ANOVA para a variavel média de pixels nas diferentes espécies.

FV GL QM
Espécies 2 3936,546*
Erro 6 63,486*
Total corrigido 8 -
Coeficiente de Variagao (%) 5,79 -

LEGENDA: FV- FONTE de Variacdo; GL-Grau de liberdade; CV- Coeficiente de variacdo; QM- Quadrado
médio; * significativo a 5% de significancia.
FONTE: Autor (2025).

Quando comparados aos resultados da analise visual, observa-se uma tendéncia que

se repete entre as espécies avaliadas. A madeira de Muiracatiara apresentou as menores notas
nas duas metodologias, indicando melhor qualidade da madeira. Na analise visual, esse
desempenho esta associado a menor presenca de defeitos visiveis, enquanto, na analise do
histograma, relaciona-se a menor variacdo nos niveis de cinza proximos ao valor maximo a
(255), resultando em superficies mais homogéneas e com menos defeitos visiveis. Do
mesmo modo ocorre nas madeiras de Eucalipto e Pinus, que apresentam valores mais
elevados nas duas metodologias. Esses resultados indicam maior presenca de defeitos
visiveis na analise visual e maior variacdo nos niveis de cinza na analise por histograma,
refletindo superficies mais heterogéneas e com maior ocorréncia de areas defeituosas.

Para reforcar essas observacGes, foi aplicado o teste de médias de Scott-Knott aos
valores médios de pixels obtidos para as trés espécies avaliadas, ao nivel de 5% de
significancia (Tabela 9). Os resultados desse teste corroboram aqueles obtidos pelas
metodologias consolidadas de analise visual e sunset laser, evidenciando a superior
qualidade superficial da madeira de Muiracatiara, 0 desempenho intermediario da madeira
de Eucalipto e a inferior qualidade superficial da madeira de Pinus.

TABELA 9 — Teste de Scott-Knott com valores médios de pixels para cada espeécie.

Espécie Meédia (pixels)
Muiracatiara 97,105 al
Eucalipto 148,801 a2

Pinus 166,910 a3




FONTE: Autor (2025). Médias seguidas dos mesmos ndmeros na mesma coluna sao estatisticamente iguais e
médias seguidas de nimeros diferentes na mesma coluna séo estatisticamente diferentes. Nao foi avaliada a
diferenca entre linhas.

Com o objetivo de estabelecer um comparativo entre os métodos testados, a Tabela
10 apresenta a relacdo entre as médias de pixels obtidas por meio da analise do histograma
e os resultados das andlises qualitativas realizadas no experimento.

TABELA 10 - Relacdo analises qualitativas e histograma.

. - o Histograma

Madeiras Analise qualitativa (8-bit/median)
Espécie Condicéo Ar_ea de Analise visual MEd'a Desv~|o
defeitos (%) (pixels) padrdo
Eucalipto 0% 0,370 3 138,327 23,630
Eucalipto Alta Umidade 0,438 3 163,968 22,072
Eucalipto Submersa 0,181 3 144,109 28,336
Pinus 0% 1,921 3 168,089 13,903
Pinus Alta Umidade 0,703 4 168,951 17,549
Pinus Submersa 2,047 3 163,690 18,863
Muiracatiara 0% 0,128 2 96,614 15,959
Muiracatiara Alta Umidade 0,151 2 98,549 17,724
Muiracatiara Submersa 0,052 2 96,153 17,459

FONTE: Autor (2025).
A aplicagéo do coeficiente de correlagdo de Pearson entre os resultados do histograma

e as metodologias de analise visual e sunset laser resultou em valores de 0,892 indicando
correlacdo forte entre a média de pixels do histograma e as notas atribuidas na analise visual,
e de 0,672, caracterizando correlacdo moderada entre a média de pixels e a porcentagem de
area de defeito. A observacgdo de correlacdes forte sugere a metodologia Opara como uma
possibilidade viavel, de baixo custo e assertividade nas classificacdes da madeira quanto sua
qualidade superficial.

Em ambos os casos, observou-se correlagdo diretamente proporcional, indicando que
menores valores atribuidos na andlise visual (melhores notas), estdo associados a menores
médias de pixels na imagem. Esse comportamento reflete uma menor variagao nos niveis de
cinza, resultando em imagens mais suaves e homogéneas, e consequentemente, em
superficies usinadas de melhor qualidade. A relacdo entre média de pixels e area de defeitos
apresentou a t mesma orientagcdo, porém com menor intensidade de associacdo quando
comparada a correlacdo com a analise visual.

YORULMAZ (2025) descreve que altos valores de variagdo dos pixels na escala de
cinza estdo associados a superficies mais complexas e heterogéneas, enquanto menores
variagdes indicam superficies mais organizadas e homogéneas. Dessa forma, regides da
madeira que apresentam maior variagdo nos niveis de cinza tendem a corresponder a
superficies irregulares, com ocorréncia de arrepiamento ou arrancamento de fibras,

evidenciadas por picos mais acentuados no histograma.



4.5. REGRESSAO LINEAR ENTRE OPARA E ANALISE VISUAL

Optou-se inicialmente pela utilizacdo da média dos niveis de cinza do histograma por
sua simplicidade, interpretacdo direta e elevada correlacdo (0,892) com a analise visual.
Embora outros pardmetros estatisticos do histograma possam fornecer informacoes
complementares, a média mostrou-se adequada para avaliar o potencial preditivo do método
proposto. No caso, o histograma passa a ser a variavel explicativa (x), e 0s métodos
consolidados passam a ser a variavel resposta (y).

A regressdo linear simples indicou relacéo diretamente proporcional entre a média de
pixels do histograma e as notas atribuidas na andlise visual. O coeficiente de determinacéao
(R?) evidenciou que grande parte da variacdo observada na avaliacdo visual da superficie da
madeira pode ser explicada pela variacdo da média dos niveis de cinza obtidos por imagens
digitalizadas. O modelo apresentou R2 = 0,796, indicando que aproximadamente 80% da
variacdo das notas da analise visual pode ser explicada pela média de pixels do histograma.
Essa relacdo gréfica entre andlise visual e do histograma encontra-se abaixo, na Figura 16.

Figura 16 — Regressdo linear simples entre histograma e andlise visual.
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FONTE: Autor (2025).

Para determinar a precisdo do modelo de regresséo, utilizou 0 RMSE, que encontrou
valores que variaram entre 0,003 e 0,284, considerados baixos. VValores reduzidos de RMSE
indicam maior capacidade do modelo em estimar a qualidade superficial da madeira a partir
do histograma. A Tabela 11 mostra um resumo da anélise de regressdo linear simples entre
os dados de médias de pixels do histograma e as notas da analise visual.

TABELA 11: Resumo da regressdo linear simples entre histograma e analise visual

Coeficiente Coeficiente de Valores
Intercepto (B0) angular (1) determinacao estimados RMSE




(R?)

2,791 0,284
3,266 0,275
2,898 0,261
3,342 0,258
0,230 0,019 0,796 3,358 0,232
3,261 0,089
2,019 0,020
2,055 0,018
2,010 0,003

FONTE: Autor (2025).

4.6. LIMITACOES DO HISTOGRAMA
Durante o desenvolvimento do trabalho foram encontradas algumas limitagcdes que

podem prejudicar ou retardar a aplicacdo da metodologia histograma em escalas maiores. O
principal entrave esté ligado a obtengdo das imagens através de um digitalizador, que limita
o tamanho das amostras analisadas, muito provavelmente, as mesmas dimensdes que uma
folha A4, dificultando a aplicando desse método para maiores superficies e corpos de prova.

Quanto ao processamento das imagens e obtencdo dos dados, o uso da média de pixels
como dado principal limita a precisao na questao qualitativa, j& que ndo consegue descrever
a dispersao dos defeitos (superficies heterogéneas), ndo representa assimetria nos corpos de
prova (defeitos localizados) e ndo diferencia superficies com mesma média, mas distribui¢do
diferente.

5. CONCLUSAO )
5.1. CONCLUSOES CIENTIFICAS
e A metodologia de rugosidade indicou que a madeira de Muiracatiara apresentou a

melhor qualidade superficial, com valor médio de 5,182 um, seguida da madeira de
Eucalipto, 5,970 um, enquanto a madeira de Pinus apresentou a pior qualidade
superficial, com valor médio de 7,538 um.

e A andlise visual classificou a madeira de Muiracatiara como a melhor qualidade da
superficie usinada, com as melhores notas (nota 2 - arrepiamento leve a médio). A
madeira de Eucalipto apresentou qualidade intermediaria (nota 3 - arrepiamento forte
e arrancamento leve), enquanto a madeira de Pinus foi classificada como a pior
qualidade superficial, apresentando com as piores notas (nota 3 - arrepiamento forte
e arrancamento leve; nota 4 - arrepiamento forte e arrancamento leve a médio).

e A metodologia sunset laser apresentou baixos valores de area de defeitos para as trés
especies testadas, com médias de 1,557% para a madeira de Pinus, 1,080% para a
madeira de Eucalipto e 0,110% para a madeira de Muiracatiara. Entre as madeiras

testadas, a madeira de Muiracatiara apresentou a melhor qualidade da superficie



usinada, seguida da madeira de Eucalipto, enquanto a madeira de Pinus apresentou a
pior qualidade da superficial.

e A metologia baseada em histograma de niveis de cinza classificou a madeira de Pinus
como aquela com maior variacdo média de pixels (166,910 pixels), seguida da
madeira de Eucalipto (148,801 pixels), enquanto a madeira de Muiracatiara
apresentou a menor variagdo meédia (97,105 pixels). Esses resultados s&o consistentes
com as metodologias consolidadas de avaliacdo da qualidade superficial da madeira,
classificando, respectivamente, as madeiras de Muiracatiara, Eucalipto e Pinus,
como de melhor, intermediéria e pior qualidade superficial.

e A metodologia Oparé pode ser empregada como metodologia alternativa a andlise
visual (ASTM D 1666-11), em funcgéo da forte correlagdo positiva observada entre
ambas (r = 0,892). Dessa forma, espera-se garantir melhores condicdes de
reprodutividade entre as micro e pequenas industrias do setor moveleiro.

e A metodologia Oparé pode ser utilizada como alternativa para avaliacéo da superficie
da madeira com a técnica de sunset laser. Embora a correlacdo entre essas duas
metodologias serem moderada (r = 0,672) a analise por histograma apresenta
vantagens operacionais, uma vez que avalia a totalidade da superficie analisada,
diferentemente do sunset laser, que se baseia em amostragens pontuais.

e Aregressao linear simples demonstra que o histograma de niveis de cinza ndo apenas
se correlaciona, mas possui potencial preditivo na estimativa da qualidade superficial
da madeira, refor¢ando sua aplicabilidade como ferramenta objetiva e de baixo custo.

5.2. RECOMENDACOES PRATICAS
e Recomenda-se a criagdo de uma nova pasta no computador apenas para

armazenamento e féacil localizacdo dessas imagens, facilitando suas analises.

6. TRABALHOS FUTUROS
e Testar a metodologia Opara com outras espécies.

e Testar diferentes pardmetros de usinagem.
e Automatizar o método (script ImageJ ou IA).
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